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Live Captions Provided

Two Options:

1. Access StreamText link available in the
“Chat” (“Chat” control in Zoom toolbar)

2. Access the “Closed Captions” option
(“Closed Captions” control with “CC”
above it in Zoom toolbar)




Spotlighting and Pinning

Spotlighting

State Agency ADA Coordinators’
Virtual Meet & Greet 2021

Only Host or Co-host can spotlight someone o=

ooooooooooooo

Whoever is spotlighted will appear in Speaker View

Pinning

Any participant can pin any other participant’s video at
any time, and it only impacts that participant’s display
How to Spotlight/Pin Participants

Hover over participant you want to spotlight/pin
Select the ellipses (...)

From the menu, choose “Spotlight for Everyone” or “Pin”



Georgia Tech — CIDI

* Research (disability-related)
* Accessibility Consulting — ICT and UX

Center for Inclusive Design and Innovation
College of Design
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e Tools for Life is celebrating 30
years of service in 2021!



Goals for Today’s Presentation

1. Discuss document accessibility and who uses
assistive technology to access content

2. Review 3 key aspects of document accessibility:
* Accessible Navigation

 Universal Design Choices

* Image Description



Today’s Presenter

Valerie Morrison, Ph.D., E-Text Manager at CIDI

Valerie Morrison manages the E-Text department at CIDI, making
accessible materials for individuals with print-related disabilities. She
earned her doctorate in English Literature from the University of Georgia
and served as an instructor of composition, contemporary poetry,
American and British literature, and the postmodern novel.

Now, Valerie and her team find innovative ways to transform course
materials quickly and affordably into a wide variety of accessible digital
formats. Valerie and her team work with university staff, publishers,
corporations, and state agencies to ensure the material they create and
distribute will be accessible to those who rely on screen readers, text to
speech software, or other assistive technology to access documents.



Document
Accessibility



Defining Accessibility

Conversational accessibility (to understand):
Can someone access the difficult language in this journal article?

Will fans find Westworld inaccessible because it has such a complicated plot?

Physical accessibility (to get in):
Can someone access the building with a Buzzcard or do we need to be let in?

Will | be granted access to Canvas to view our discussion posts?

Digital accessibility (to meet accessibility guidelines):
Can someone navigate through this document with accessible headings?

Will images be described in this file with accessible alternative text?



What Needs to Be Accessible?

Ideally, everything in an educational environment or posted online should
be made accessible:

e Textbooks and Course Materials

* Course Syllabi and Exams
* Course Packets

* Courses Websites
 Readings and Handouts

e PowerPoint Lectures




Who Needs Accessible Documents?

Digital Accessibility means that your documents and websites are
accessible to individuals using assistive technology.

* Individuals who are blind, or experience color blindness or low vision

* Individuals with learning disabilities such as dyslexia, dyscalculia,
dysgraphia, or ADHD

* Individuals with head injuries, trauma, or cognitive disabilities

e Auditory learners

* Aging population

* Everyone



Assistive Technology in Action
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Harley's Story: Using Assistive Technology in the Classroom



https://www.youtube.com/watch?v=-IiRCFxjB3Y

3 Tips for Greater Accessibility

Keep these 3 ideas in mind for greater accessibility across all programs:

1. Is my content easy to navigate?
Have | created headings and bookmarks for easy navigation?

2. Are my design choices accessible?
Have | chosen fonts, colors, and backgrounds that are easy to discern?

3. Are my visuals clearly and fully described?
Have | written alt text descriptions and captions for my images?



Accessible Navigation



Adding Accessible Headings in Microsoft Word

AaBbCcDc AaBbCcDe | AaBbC AaBbCcl Aat‘; ;

TMormal T Mo Spac...  Heading 1| Heading 2 Title =

Styles [~

* Highlight a word or line in your document and select a
Heading Level in the Styles group on the Home Ribbon.

 Add different levels of Headings to provide
organizational structure and allow individuals using
assistive technology to easily navigate your content.



Viewing Headings in the Navigation Pane

Click the View Tab and check the Navigation Pane box to
view all the headings in the document.
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[ Ml Ll [=] Outline Ruler q [b} E] One Page = E -
2 100 ] -

' [F] Draft Gridlines EE Multiple Pages

Read @ Prnnt Web Naviaation P foom 100% _ New Arrange 5Spl
Mode Layout Layout @ € Page Width Window  All

Views Show Zoom
Navigation M

‘Dual enrollment and Un

Search document O~

and practices
HEADINGS  PAGES RESULTS

z February 2016

Dual enrollment and University System of Georgi... The University System of Georgiz

1



Customizing Headings

Documentl - Word
SLAYOUT  REFEREMCES  MAILIMGS  REVIEW  VIEW  Accessibility  ABBEYY FineReader12 ~ ACROBAT
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* Right click on a Heading Style 8= =
on the Home Tab and then
select Style to modify your
formatting options.
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gallery, Priority: 10
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Adding Bookmarks for PDF Files in Adobe Acrobat

* Highlight text and right
H D:} *E—* click, or press CTRL + B
to create bookmarks.

= [:l Acing Business Associations: A Checklist

_ e * To adjust the hierarchy,
Approach to Business Associations

drag them up and

| Acknowledgements under the “parent

_| Table of Contents bookmark™ so they

B appear indented.

A Introduction .
B * You can edit the text of
-l Chapter 1: Agency a bookmark, to include
: Chapter Z2: General Partnerships the word “Chapter” for
B instance.
.| Chapter 3: The Structure of the Corporation




Adding Descriptive Slide Titles in PowerPoint

Each slide should have a
unique descriptive title to
help someone navigate
through the presentation.

Slide titles help everyone
understand and focus on
your key points and know
where you are in your
presentation.

3 CIDI's Products and Services
« E-Text Services
« Braille Services
» Captioning and Audio Description Services
« Certified Assistive Technology Tools for Life Team
= ICT Accessibility Consultations and Website Evaluations

4 Goals for Today’'s Presentation
1. Discuss the top three considerations for document accessibility:
= clear navigation
= alt text for images
= simple design
2. Provide an overview of PowerPoint accessibility

5 Document Accessibility Tips

6 Who MNeeds Accessible Documents?
Digital Accessibility means that your documents and websites are accessible to individuals
using assistive technology.
» Individuals who are blind, or expenence color blindness or low vision
» Indinviduals with learning disabilities such as dyslexia, dyscalculia, dysgraphia, or ADHD
» Individuals with head injuries, trauma, or cognitive disabilities
= Auditory learners
= Aging population
= Everyone



Universal Design
Choices



Defining Universal Design

* Definition: Universal Design is the design and composition of an environment
so that it can be accessed, understood and used to the greatest extent possible
by all people regardless of their age, size, ability or disability.

 The 7 principles of Universal Design are as follows:

1. Equitable Use
. Flexibility in Use

. Simple and Intuitive Use

. Tolerance for Error

2
3
4. Perceptible Information
5
6. Low Physical Effort

7

. Size and Space for Approach and Use



Document Design and Style Considerations

* Font size. Sans serif fonts are best (Calibri, Arial, Verdana, Helvitica, Geneva).

* Font style. Avoid large amounts of italicized, bold, underlined, or capitalized
text.

e Color choices. Do not rely on color coding alone to convey meaning.

* Color contrast. The colors of text and background should have a high contrast
ratio to reduce eye strain (yellow text on black background is most accessible).

* Backgrounds and images. Avoid busy patterns that are bright and distracting.



Accessible Fonts

 Font size should be 12

point font minimum to Center for Inclusive Design and Innovation (Calibri)

be read by most users. Center for Inclusive Design and Innovation (Arial)

* Sans serif fonts are best: Center for Inclusive Design and Innovation (Verdana)
Calibri, Arial, Verdana, Center for Inclusive Design and Innovation (Times New Roman)
and Geneva. Center for Inclusive Design and Innovation (Georgia)

e Avoid la rge amounts of Center for Inclusive Design and Innavation (Script )

italicized, bold,
underlined, or
capitalized text.



Color Contrast

Color contrast should
reduce eye strain

Use the free Colour
Contrast Analyser from
the The Paciello Group
(www.paciellogroup.org).

Do not rely on color
coding alone to convey
meaning.

& Colour Contrast Analyser (CCA) Edit
A A

Contrast ratio 1.6:1

Foreground colour

#F1B548

Colour blindness simulation

a
L

| Background colour Monochromacy
Achromatopsia (1.7:1) Achromatomaly (1.7:1)
#DA7C46 no color almost no color

Dichromacy

v Sample preview Protanopia (1.7:1) Deuteranopia (1.7:1) Tritanopia (1.6:1)

no red no green no blue

Trichromacy

Protanomaly Deuteranomaly Tritanomaly
WCAG 2.1 results (1.7:1) 1.7:1) (1.6:1)

1 d I low bl
» 1.4.3 Contrast (Minimum) (AA) o Rl S

Q Fail for large and regular text

¥ 1.4.6 Contrast (Enhanced) (AAA)

Text (including images of text) has a

contrast ratio of at least 7:1 for "regular" sized text
and at least 4.5:1 for large scale text (at least [18pt |/
24px |, or bold and at least |14pt|/[18.5px ), unless
the text is purely decorative.

Q Fail for large and regular text

P

» 1.4.11 Non-text Contrast (AA)

Q Fail for Ul components and graphical objects



https://github.com/ThePacielloGroup/CCA-Win/releases/

Accessible Spacing

 Delete any repeated spaces, tabs, or hard line breaks and put your cursor
before or after the word where you want white space.

 Then use the Paragraph Settings on the Layout Tab, add space before or after
the line you have selected.

* You can also create section breaks or alter your margins on this tab to change
the layout of your page as needed.

File Home Insert Design Layout References Mailings Review View
fe— L
5 ==| T Breaks~ Indent Spacin
| B 0 B E o5,
;- Line Mumbers ~ += lefe D" 1 = Before: 0 pt

Margins Orientation  5ize Columns
3 - V 2 bc Hyphenation ~
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) Té After 8pt

© Right: 0"

Page Setup [ Paragraph M



Inserting Accessible Page Breaks

Instead of hitting Enter multiple times and having the screen reader repeat the
phrase “Blank Line,” try inserting a page break.

Put your cursor after the last line on your page and go to the Insert Tab.

* Select Page Break to split content.

File Home Insert Design Layout References
= Cover Page ~ i:_!_ ar |-_|:I:| Shapes ~ I SmartArt
N Blank Page = ‘?El lcons d]]l:harl'

Table Fictures

'ﬁ Page Break & 2 fffl 30 Models ~ %; Screenshot ~

Fages Tables [llustrations



Document Content and Organization

* Organize material with clear headings or bookmarks with a logical structure.
* Use headings to create an accessible table of contents if possible.
Do not interrupt the main body text with images, footnotes, captions, or tables.

* Explain all acronyms, symbols, and abbreviations for your audience at the top of
the page, not the bottom.

* Include captions for both images and tables that are accessible to everyone. This
also allows for image description to be fairly brief.



Accessible Tables

Accessible Tables SHOULD Accessible Tables SHOULD NOT

* Have a specified header row

Should not contain merged cells
 Have a logical reading order

Should not contain empty cells
e Contain related information

Should not contain images
 Have a descriptive title

 Have a descriptive caption

* Contain equal numbers of cells in all
rows and columns



Adding a Table Header Row

e All tables should have one header row.

* To specify the header row, select the table and click the Table Design Tab.

e Now check the box for Header Row.

e - @B G 9+ 0 - e ——

File Home  Insert Design Layout References Mailings Review Wiew Help  ABBYY FineReader 12 Acrobat  Table Design Layout
~| Header Row First Column SR R S el E— <'7ﬁ - L
Total Row Last Column SEEEE EEEEE EEEEE -oooo -z oot Ml v pt N P
o I Y 0 e A e e o e s o —| Shading Border o Borders Border
Banded Rows Banded Columns - Styles v & Pen Color ~ BN it
Table Style Options Table Styles Borders ]
L | R R B G T .,
I Salary
- -+
i Movie Salary|
i Youngblood (1986) 53,000
Speed (1994) $1,200,000
Johnny Mnemonic (1995) 52,000,000




Image Description



Adding Alt Text to a Microsoft Word File

TR b e 8 Alt Text - x To add alternative text:
How would you describe this object and its . . .
:,E::ﬁtm zomeone wha is blind or low ® nght_cllck on the |mage
el and choose Edit Alt Text.
- The actions or interactions
- Other relevant information O If you do nOt See the
(1-2 detailed sentences recommended) Edit Alt Text Option’

select Picture and then
click on the Alt Text tab.

* Type in the description
field using proper
grammar, spacing, and
punctuation.

e Do not use hard line
breaks to create
separate paragraphs.




Adding Alt Text to a PDF File

* |If you need to add alt text to an
image in Acrobat, first click on
Tools, and select Accessibility.

e Select the Reading Order tool
and scroll through your file
looking for images. Right click
to add alt text.

* Running the accessibility report
will also flag these images and
allow you to click on them and
add alt text.

proithodira bongs us quite close fo the ancestry of
3 bsaurs. This group i composed of two monophy
groups, Dinosauria (defnos - terrible) and Prerosauria
(prero - winged: Figure 4.13). Thar pierosawrs are
unapologetically Mesozoic archesaurs has led to their
being called "dinosaurs"; that they had wings and flew
haz led seme to mistake them for birds: but in fact they
were something utterly different from edither dinosaurs or
birds. They were unique, magnificent. and now, sadly,
Very extinct.

I'I osaurs

Thiz climb up the cladogram leawes us wheezing and
gasping for air. but at long last simated at the subject of
oar book: Dinosauria. Dinosauria ‘is formally defined
as Tricerarop:  Aorridus, Porser domestious  (Spammow;
a represenfative derived bird), amd all members of the
clade descended from their most recent common
AnCestor

Dinpsaurs can be diaznosed by a host of shared, derived
characters. These are anatomically quite desatled, and a few
are listed in Figure 4.14 and illustrated in Figure 415
Among the most accessible are the perforate acembulum
(an opening in the hip socket), large muscls attachment
scars revealing that the jow closing muscles arached to
the top of the skull (unusnally large muscolature suggesting
a distinctively powerful bite), and a well-developed. elong—
ate deltopectoral crast on the bumerns {upper arm), indicat-
ing unusual forelimh power.

Standing tall

While these characters appear to fall within the realm of
dinosaur mimutias, thers is one quality dinesaurs possess
that dees pot: an erect, or parasagittal stance; that
stance in which the plans of the legs is parallel to the
vertical (mimor imaps) plane of the torso (see
Fipure 4.11). This stance is also present in a few arch-
osaurs very clese to Dinosauria (s== Chapter 5) bat
becauss it is truly emblematic of Dinosauria, we include
it here.

In dimosaurs, am erect stance comsists of a suite of
anatomical featores with important behavioral impli
tions (Box 4.3). The head of the femur (thigh beme) is
orisnted at approximatel

w412, An schossur soull with S diag

reesira

reostic antartd

%
- .‘ L

e 4.13. A cose relatve of Dincss
ind by o péesmdactyloid ptemsur, from
arFEia

FIErOSaUra. as
he Crefaceous

90° to the shaft The head of the femur it

is barrel-shaped (unlike

the familiar ball shape seen in a buman femur). so that motion in the thigh is restricted larzely o




How to Describe Images

. . . NDIINA
* First summarize what you see in one IIDUNNOIMAN

general informative sentence.

 Keep your description neutral and
informative.

e Use proper grammar, spelling and
punctuation.

* Avoid acronyms and symbols.




Simple Images

Photographs of people
just need a name:
Martin Luther King, Jr.

Simple graphics can often be described in one sentence:
A magnified image of the human coronavirus.

Additional details about its spherical structure and the
projecting glycoproteins could be added depending on
your audience and context.



Bar Graphs

Popu|ct’rion (%)

U.S. Popu|c+ion loy Race

2000 2025
Yed I

Other
Il Black
Il Hispanic

B White

\ />
P

visme

Work from general to specific. Begin by
naming the type of graph and title. Then
describe the horizontal and vertical axes if
applicable. Finally, describe the data.

A bar graph titled U.S. Population by Race
that compares the percentages of Black,
Hispanic, White, and Other races in the
United States for the years 1990, 2000,
projected 2025, and projected 2050. In
1990, there were 76% White, 9% Hispanic,
12% Black, and 3% Other. In 2000, there
were...



Focus on Meaning

e Avoid the common mistake of spending your
time describing the appearance of symbols Y

rather than their meaning. S o \

 Example: In this image, you would want to
avoid describing “a ball labeled with a plus
sign” and instead you should call it “a
positron.” Avoid describing “a squiggly =
arrow labeled with a weird y” and instead v
call it “a gamma ray.”



Consider Cognitive Load

Cognitive load, also referred to as Auditory
Fatigue, is something to consider when
describing images, so that you don’t
overwhelm the listener’s working memory.

Begin with the type of image.

Follow up with a one sentence overview
that provides a general summary of the
content.

Work from general to specific, filling in the
details as needed.

UNIVERSE INFOGRAPHIC ELEMENTS

TEMPERATURE ON PLANETS MILKY WAY GALAXY STRUCTURE MOON EXPEDITIONS
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RO LUNOKHOD 2 cumosmf
SOLAR SYSTEM i G &
g o ASTRONAUT SPACESUIT COMPONENTS " ‘###® - -
: = e viealy) SPA_CE STAT_iON !
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EARTH STRUCTURE
SOLAR SYSTEM DISTANCE :' C
@) CJ ] C CRUST
J (7'1 MANTLE
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Georgia ﬁ Center for Inclusive
Tech -:Lj‘l:lesign and Innovation

Questions and Answers



Georgla Center for Inclusive
Design and Innovation

Contact Us

T

Contact our Customer Support Team
by phone (404) 894-7756 or by email
cidi-support@design.gatech.edu
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